foAkene? | TT-2 AFM

This compact, second For:

generation tabletop Atomic .
» Nanotechnology Engineers/Researchers

Force Microscope has all the Wanting to do routine scanning of nano-structures.

important features and benefits
» Instrument Innovators

expected from a light Using AFM as a platform to create a new instrument.

lever AFM.

» Educators

Teaching students about AFM construction, operation, and
applications.

upto1”"x1"x3/4"

Vibrating (Tapping), Non Vibrating (Contact), Phase, LFM
50x50x 17 pm; 15 x 15 x 7 um

Zoom to 400X, 2 um resolution

Compact Tabletop Design



STAGE

The TT-2 AFM Stage has
excellent thermal and mechanical
stability required for high
resolution AFM scanning.
Additionally, its open design

facilitates user modification.

Rigid Frame Design

The crossed beam design for the stage support is extremely rigid so
the AFM is less susceptible to external vibrations.

Light Lever AFM Force Sensor

Light lever force sensors are used in almost all atomic force
microscopes and permit many types of experiments.

Integrated Probe Holder/Probe Exchanger

A unique probe holder and clipping mechanism allows quick and
easy probe exchange.

Direct Drive Z stage

A linear motion stage is used to move the probe in a perpendicular
motion to the sample. Probe/sample angle alignment is not required,
facilitating a much faster probe approach.

Small Footprint

The stage dimensions of 4" X 7" require little space and fit easily on
a tabletop.

Precision XY Stage with Micrometer

The sample is moved relative to the probe with a precision XY
micrometer stage. Thus, the sample can be moved without touch.

Modes Electric Plug

A six pole electrical plug is located at the back of the stage to expand
the capabilities of the TT-2 AFM.

XYZ Precision Piezo Scanner

The modified tripod design utilizes temperature compensated strain
gauges which assure accurate measurements from images. Also,
with this design it is possible to rapidly zoom into a feature visualized
in an image.

Laser/Detector Alignment

Both the light lever laser and the photo detector adjustment
mechanism may be directly viewed. This feature simplifies the laser/
detector alignment.

Adaptable Sample Holder

At the top of the XYZ scanner is a removable cap that holds the
sample. The cap can be modified - or a new cap can be designed - to
hold many types of samples.

High resolution video microscope
Direct drive Z motor stage

Light lever force sensor

Mode input/output plug

XYZ linearized piezo scanner

XY sample translation stage

FM v1.8
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EBOX

Electronics in the TT-2 AFM are > 24-bit scan DAC
) Scanning waveforms for generating precision motion in the XY axis
constructed around industry- with the piezo scanners are created with 24-bit DACS driven by a

32-bit micro controller. With 24-bit scanning, the highest resolution
AFM images may be measured. Feedback control using the XY strain
gauges assures accurate tracking of the probe over the surface.

standard USB data acquisition

electronics. The critical functions,
» Phase and Amplitude Detector Circuit

Phase and amplitude in the Ebox are measured with highly stable
phase and amplitude chips. The system can be configured to feed
back on either phase or amplitude when scanning in vibrating mode.

such as XY scanning, are optimized
with a 24-bit digital to analog

converter. With the analog Z » Signal Accessible

feedback loop, the highest fidelity At the rear of the Ebox i.s 8.50 pin ribbon cabl.e that gives access to all
of the primary electronic signals without having to open the Ebox.

scanning is possible. Vibrating » Status Lights

mode scanning is possible At the front of the Ebox is a light panel that has 7 lights. In
the unlikely event of a circuit failure, these lights are used for
with both phase and amplitude determining the status of the Ebox power supplies.
feedback using the high sensitivity > Precision Analog Feedback

Feedback from the light lever force sensor to the Z piezoceramic is

phase detection electronics. made using a precision analog feedback circuit. The position of the
probe may be fixed in the vertical direction with a sample-and-hold
circuit.

» Variable Gain High Voltage Piezo Drivers
An improved signal to noise ratio, as well as extremely small scan
. ranges are possible with the variable gain high voltage piezo drivers.

Microprocessor for scan generation through 24-bit DAC's

Low noise, variable gain high voltage amplifiers with PID
feedback for XY scanning

Dimensions: Width 6" | Height 10" | Depth 14"

High fidelity, low noise Z feedback circuits for accurate
probe tracking

--H ¢ Phase and amplitude detection circuits for vibrating
\ ¢ Industry-standard National Instruments USB data

acquisition board
Internally accessible header for signal input/output

Eight channels of ADC for monitoring and displaying data
with LabVIEW™ software

FM v1.8
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SOFTWARE

Software for acquiring > Pre-scan Window
T A pre-scan window

i | Rt | e |

images is designed with the N e — includes all of the
EER r—w o _ . functions required before
industry-standard LabVIEW™ T [LofSE e a scan is started. The
; i o R = functions are presented
programming visual interface i LU in a logical sequence on
Ptz the screen.

—— i .

] ] s

¥ - | ey | T
- i'<
]

instrument design environment.

PRE P T TR T O LR CROe 0

There are many functions,

including setting scanning

parameters, probe approach,

Once all the stepsin
the pre-scan window
are completed, the scan
window is used for
measuring images. Scan
parameter, Z feedback
parameters, and image
view functions may be
changed with dialogs on
this screen.

frequency tuning, and displaying
images in real time.

LabVIEW™ facilitates rapid
development for those users
seeking to enhance the software

with additional special features.

LabVIEW™ also enables the

TT-2 AFM to be readily combined » LabVIEW™ Window
. . Industry-standard

with any other instrument B DG e AR B programming

B “| environment.
using LabVIEW™ VI, =1 Readily customized
B By i = = |l and modified for
i a1 = specialized applications.
ha @ Instrumentation already
fEpeted using LabVIEW™ can be
ey A Ul added to the TT-2 AFM to
o & e =l | create new capabilities.

Ll | as
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IMAGE ANALYSIS

SOFTWARE

Included with the TT-2 AFM is

Gwyddion open source SPM image

analysis software. This complete

image analysis package has all the

software functions necessary to

process, analyze and display

AFM

WORKEHOPR,

SPM images.

File
Edit
Ciata Process
Greph
Meta
= Wiew

IOBCORCHn |

[=] Drata Proceéss

Vil e & @

A N\
@) M 38

v1.8

»

Visualization: false color representation with different types of mapping

Shaded, logarithmic, gradient- and edge-detected, local contrast
representation, Canny lines

OpenGL 3D data display: false color or material representation
Easily editable color maps and OpenGL materials

Basic operations: rotation, flipping, inversion, data arithmetic, crop,
resampling

Leveling: plane leveling, profiles leveling, three-point leveling, facet leveling,
polynomial background removal, leveling along user-defined lines

Value reading, distance and angle measurement

Profiles: profile extraction, measuring distances in profile graph, profile
export

Filtering: mean, median, conservative denoise, Kuwahara, minimum,
maximum, checker pattern removal

General convolution filter with user-defined kernel

Statistical functions: Ra, RMS, projected and surface area, inclination,
histograms, 1D and 2D correlation functions, PSDF, 1D and 2D angular
distributions, Minkowski functionals, facet orientation analysis

Statistical quantities calculated from area under arbitrary mask
Row/column statistical quantities plots

ISO roughness parameter evaluation

Grains: threshold marking and un-marking, watershed marking

Grain statistics: overall and distributions of size, height, area, volume,
boundary length, bounding dimensions

Integral transforms: 2D FFT, 2D continuous wavelet transform (CWT), 2D
discrete wavelet transform (DWT), wavelet anisotropy detection

Fractal dimension analysis

Data correction: spot remove, outlier marking, scar marking, several line
correction methods (median, modus)

Removal of data under arbitrary mask using Laplace or fractal
interpolation

Automatic XY plane rotation correction
Arbitrary polynomial deformation on XY plane
1D and 2D FFT filtering

Fast scan axis drift correction

Mask editing: adding, removing or intersecting with rectangles and
ellipses, inversion, extraction, expansion, shrinking

Simple graph function fitting, critical dimension determination
Force-distance curve fitting

Axes scale calibration

Merging and immersion of images

Tip modeling, blind estimation, dilation and erosion
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VIDEO
MICROSCOPE

A video optical microscope in an

AFM serves three functions: aligning
the laser onto the cantilever in
the light lever of the AFM, locating

surface features for scanning, and

TET T LI

Bl 111

facilitating probe approach. The TT-2
AFM includes a high performance

video optical microscope along with

a 3 megapixel camera, light source,

Here the video optical microscope allows viewing features
on a test structure. The AFM cantilever is on the right.
Three images show results of areas selected for

AFM scanning.

microscope stand, and Windows

software for displaying images.

Laser alignment is greatly
facilitated with the video
optical microscope. This
vibrating cantilever is

250 pm long. The red spot is
from the laser reflecting off
the cantilever.

The video optical microscope
zooms in to show an HOPG
sample surface and the

AFM cantilever.

FM v1.8
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PROBE HOLDER/
EXCHANGE

The TT-2 AFM utilizes a unique probe
older/exchange mechanism. Probes
are held in place with a spring device
that mates with a probe

exchange tool.

This combination makes changing

probes fast and easy on the TT-2 AFM.

SCANNING MODES

Standard with every TT-2 AFM are
nonvibrating (contact) mode and
vibrating (tapping) modes for creating
topography scans.

Additional modes included with the
product are lateral force imaging and

phase mode imaging.

Any scanning mode that can be
implemented with a light lever AFM is

possible with the TT-2 AFM.

Probe holder
Probe inserted in clip

Probe exchange tool

Tt Frequescy
Aglibse Phase
= [Beg) rl'mrﬁm-ﬁ :
b - L
&= m' | v : Babeeed ()|
;'l 100 “-":P.-'H-'-WM
0- l |
....... |J
s.000 jlui
P00 JRAS00 275000 275500 J7R000 2S00 2000 27TS00 27A000

Fraguarcy (i)

With the window above the resonance frequency of a cantilever is readily
measured. Additionally, the phase characteristics of the probe-sample
interaction may be captured.
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WORKBEHOR
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TT1-2 AFM IMAGES

With a vertical noise floor of

0.1 um and a horizontal resolution
of 2 um, most types of samples
may be imaged with the TT-2 AFM.

These include hard as well as

SOft Samples- e.coli w/flagellum, 6 pm x 6 um 3pm x 3 um phase image, bacteria Tumx T um, DNA

OPEN DESIGN

An open deSign is at the core MEMS multiple level gear 40 pum x 40 pm, Silicon test pattern 7 x 7 um - defect

of all products offered by the
AFM Workshop. New types of
experiments are more readily
designed and implemented
through the use of LabVIEW™
software. All the mechanical
drawings for the TT-2 AFM are

available in the documentation

atomic terraces on Si sample, each
terrace is 0.3 nm high

package option. Finally, the
company's website offers a Users

Forum to directly share specialized

designs developed for the TT-2

AFM. For specialized applications,
other types of scanners such as
flexure and tubes can be easily

added to the microscope stage.

Polymer phase image, 5 pm x 5 upm 25 x 25 um - parasites 300 x 300 nm -phase PMMA

FM v1.8
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TT1-2 AFM OPTIONS '

Although the TT-2 AFM comes with
everything you need to make AFM
images, several additional

options are available.

AFMWorkshop regularly develops

new options.

Contact AFMWorkshop for
information on options for
the TT-2 AFM. >

Dunk and Scan Probe Holder

Open liquid cell for scanning samples submerged In liquids.
Can directly replace the TT-2 AFM probe holder or the NP/SA/or
LS-AFM probe holder.

/ > Environmental Cell
Permits scanning in inert environments or liquid.
» High Resolution Scanner
Allows arange of 15 um X 15 um in XY and 7 um in Z.

Environmental cell » Acoustic Enclosures

7

Reduces unwanted acoustic and structural vibrations.

» Conductive AFM

Measures the 2D conductivity of sample surfaces.

> Magnetic Force Microscopy

Measures surface magnetic field by incorporating a magnetic probe
into the AFM.

> Lithography

Enables the probe to alter the physical or

15 ym scanner . .
chemical properties of a sample source.

> Image Logger

Display six images changes with forward and reverse displays, six
data channels and spectrum analyzer.

» Motorized Focus

Facilitates rapid tip approach as well as more accurate focus control

FM v1.8
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TT1-2 AFM ADVANCED CONFIGURATION

The TT-2 AFM Advanced Included with the packaged is:
Configuration gives all of the > TT-2AFM
_ » 50 yum and 15 ym Scanner
advanced features required
» Motorized Focus
for demanding projects. » Advanced Force Distance

> Image Logger
» Acoustic Cabinet, Bungee Option, and Base Cabinet
» Documentation Package with all schematics, mechanical

drawings, and software protocols

> Break out box.

The TT-2 AFM Advanced Configuration package offers a
substantial discount versus purchasing them separately.
Most importantly, purchasing the package ensures you
are ready for demanding projects as soon as the AFM is
delivered to your lab.

FM v1.8
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SPECIFICATIONS

>

50 Micron XYZ Scanner

Type

XY Linearity
XY Range

XY resolution

XY Actuator type
Sensor type

Z Range

Z Linearity

Z sensor noise

Z feedback noise
Z Actuator Type

Z Sensor type

15 Micron XYZ Scanner

Type

XY Linearity
XY Range

XY resolution

XY Actuator type
Sensor type

Z Range

Z Linearity

Z feedback noise
Z Actuator Type

Z Sensor type

Sample Holder

»

»

»

Light Lever AFM Force Sensor

»

»

Type
Max Lateral Dimensions
Max. Height

Probe Types
Probe insertion

Probe holding mechanism

Laser/Detector adjustment range

Adjustment resolution

Minimum Probe to Objective

Laser Type
Detector
Type
Band Width
Signals Transmitted
Gain
Probe sample angle

FM v1.8

WORKEHOPR,

Modified tripod
<1%

>50 um

<3 nm closed loop
<1 nm open loop
Piezo

Strain Gauge

> 17 um

<b%

<1 nm

<0.15 nm*

Piezo

Strain Gauge

Modified tripod
<1%

> 15 um

<1 nm closed loop
< 0.3 nm open loop
Piezo

Strain Gauge

>7 pum

<5 %

<0.08 nm*

Piezo

None

Magnet
1"
0.75"

Industry-standard
Manual -

probe exchange tool
Clip

Vibrating mode piezo
Electrical connector to
probe

+/-1.5mm

Tum

25 mm

670 nm diode, < 1T mw

4 quadrant

> 500 kHz
TL,BL, TR, BR
Lo, High Settings
10°

p XY Translator
» Range
» Resolution
» Type
loaded
» Lock Down

> Z Motion
» Type
» Range
» Drive Type
» Min. Step Size
» Slew Rate

» Limit Switch Top, Bottom

» Control

> Digital Data Input Output

» Connection
» Scanning DAC
Number
Bits
Frequency
» Control DAC
Number
Bits
Frequency
» ADC
Number
Bits
Frequency

P Analog Electronics

» Vibrating Mode
Freq Range
Output Voltage

» Z Feedback
Type
Bandwidth
Sample Hold
Voltage

» XY Scan
Voltage
Bandwidth
Pan & Zoom

» Tip Approach Cutoff

25.4 mm
2 um
Bearing - spring

Yes

Direct Drive
25 mm
Stepper Motor
330 nm

8 mm/minute

Software - rate,
step size

USB

24
7 kHz

16
2 kHz

16
48 kHz

2 kHz — 800 kHz
10 Vpp

PID
> 3 kHz
Yes
0-150V

0-150V

> 200 Hz

22 Bits

> 20 um sec.
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SPECIFICATIONS cowrinvven.

p Software
»  Environment LabVIEW™
» Operating System Windows

» Image Acquisition Real Time Display
(2 of 8 channels)

» Control Parameters

PID Yes
Setpoint Yes
Range Yes
Scan Rate Yes
Image Rotate 0 and 90°
» Laser Align Yes
» Vibrating Freq. Display Yes
» Force Distance Yes
» Tip Approach Yes
» Oscilloscope Yes
» Image Store Format Industry-standard
» Image Pixels 16 x 16 to 1024 x 1024
» H.\V. Gain Control XY and Z

Line Level,

Light Shaded,
Grey Color Pallet
» Calibration System Window
» Probe Center Yes

» Real time display

FM v1.8

> Video Microscope
Field of view 2X2mm
Working Distance 114 mm 114 mm

» Computer
» Industry-Standard Computer & Monitor
(laptop available upon request)
» Windows
» AFMWorkshop LabVIEW.exe installed

300 X300 u

* Z Noise performance depends greatly on the operating environment
of the TT-2 AFM. Best Z noise performance is obtained in a vibration
free environment.We recommend using a vibrating cabinet.

** Every effort is made to present accurate specifications, however, due
to circumstances beyond the AFMWorkshop’s control specifications
are subject to change.

“* All specifications are accurate to +/-5%.
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